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1 Introduction 

Data1 stored in the NVS Databank has great potential to assist in the management of 
New Zealand’s unique biodiversity. Such vegetation data can offer unique insights 
into vegetation distribution and dynamics, over regional and national scales (e.g. 
Wiser et al. 1998, Allen et al. 1999, Bellingham et al. 1999). This manual contains a 
brief introduction to using the data entry module of NVS Express, a program 
developed by Landcare Research, to assist with entry and validation of vegetation 
plot data stored within the National Vegetation Survey (NVS) Databank. This module 
will subsequently be referred to as ‘NVS Data entry’ and was formerly known as 
‘NVS Lite’. 
 
Recent progress on the NVS Databank has focused on the development of NVS into 
a permanent and stable vegetation data management system (Fig. 1). Development 
of suitable data entry facilities was identified as one of the first steps along an overall 
pathway, in which tools and applications will become available to validate, exchange, 
convert, summarise and analyse data stored within NVS (see Richardson et al. 
2005). It is envisaged that such tools will be readily available, and will afford 
significant benefits to end-users, including the Department of Conservation, regional 
councils, universities and others. 
 
NVS Data entry was tailored for entry of data collected using standard forest 
monitoring methods (i.e. permanent 20×20-m plots) and vegetation inventory 
methods (i.e. the Recce method; see http://nvs.landcareresearch.co.nz/). These are 
two of the main types of vegetation data currently stored within NVS. Purpose-built 
data entry applications afford a number of benefits, some of which are as follows: 

 Data can be easily entered directly by the person who undertook the data 
collection. These people are often the best placed to resolve any errors that 
are identified during data entry. 

 The range of values that may be entered within each data-field can be 
bounded, so only appropriate data entries can be accepted; unrecognised 
values are highlighted during data validation.  

 Data is validated during and following data entry: both errors and warnings 
are given. For example, if certain data has not been entered for a plot or 
subplot, a warning is initiated highlighting the potential accidental omission.  

 Data is entered in formats that are inherently intuitive to users, i.e. entered 
data appears largely as it does on field-sheets, allowing it to be more easily 
entered and checked.  

 Inbuilt point-of-data-entry checks are conducted against species codes. The 
presence of invalid or unknown species codes can be one of the most 
problematic issues when using vegetation data. In NVS Data entry, all 

                                            
 
1
 Data (= information stored in a database) is used in the singular throughout this manual. 
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species codes entered are checked against those currently recognised in 
NVS. 

 For stem diameter data, inbuilt point-of-data-entry checks are conducted 
against tag numbers, excluding any possibility that unidentified duplicate tag 
numbers will result within the same plot in a dataset. 

 When data is uploaded into the NVS Databank for permanent archiving, more 
comprehensive and sophisticated validation procedures can be conducted. 

 
Not all variations to the standard vegetation inventory and monitoring methods can 
be accommodated in NVS Data entry. The full NVS Databank system affords greater 
flexibility, encompassing many alternative or additional methods and options. A 
minimum of flexibility is retained in NVS Data entry, for example, plot sizes may be 
changed where they deviate from standard plot measurement protocols. In NVS 
Data entry, this limited capacity to accommodate method variations and options 
allows the program to remain as user-friendly as possible; however, as a result it is 
not suitable to be used for the entry of all types of vegetation data.  
 
For further information on NVS Express; or other NVS developments, please contact 
NVS by email (nvs@landcareresearch.co.nz).  
 

Paper Records

Local Data Tool

Data Upload Process Databank Management Tool

Field Data Collection

Post Data Entry Validation and Integrity Checks

Web

Excel

XML

Text

Web Services

 
 

Fig. 1 Schematic workflow diagram of the data collection, entry and storage 
processes, when using the NVS Databank as the data repository. 
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2 Getting Started 

2.1 Installation 

 
The NVS Express installation package can be downloaded via the Internet (see 
http://nvs.landcareresearch.co.nz/). NVS Express is a Windows application and will 
run on Windows 2000 and above.  
 
Users need to register and log in to the NVS Databank before being able to 
download NVS Express. A valid email address and self-selected password are 
needed for registration. Registration allows us to notify all NVS Express users when 
new versions of NVS Express or the authority lists are available, and also means 
that the NVS Databank is ready to accept data deposits uploaded via the NVS 
website. 
 
In some cases NVS Express may be available from your organisation’s computer 
support staff. Please contact the appropriate support person in your organisation to 
find out how to get the application installed (e.g. Department of Conservation staff 
should contact their network system administrator).  
 
Any previous version of NVS Express must be removed before a new version can be 
installed. In a network environment, NVS Express must be installed directly on all 
local drives of those computers from which it will need to be accessed.  
 

 The NVS Express tool requires that the Microsoft .net framework is loaded on 
your computer. If the .Net framework is not present on your computer you will 
be asked to download this as part of the installation process. 

 The installation package contains the file ‘setup.exe’. This is the application 
file. Double-click on this file and accept the default options to install NVS 
Express to the default Program files folder. To install NVS Express 
elsewhere, navigate to the appropriate folder.  

 When installation is complete, a shortcut icon will be added to your desktop, if 
not, navigate to the folder to start the application or save NVS.exe as a 
shortcut to the desktop or pin the program to the start menu. The default 
location for the application is at C:\Program Files\Landcare Research\NVS. 

 

2.2 Location of NVS Express project files 

 
NVS Express projects are stored as files on the hard drive of the computer used for 
data entry. This means that it is recommended that only one computer is used for 
entering data for any particular project. If it is necessary to move NVS Express 
project files onto another computer, you will need to move the project file (with 
extension .mdb) found at: 
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………\My Documents\NVS Projects\  

and the party data, usually found at:  

C:\Program Files\Landcare Research\NVS\Resources\ NVS_PartyData_Local.mdb  

Ensure that the NVS Express program is closed before moving these files. Note that 
these programs are only recognized by the NVS Express program and cannot be 
opened directly. If you wish to use the data in another program you will need to open 
the file in NVS Express and export it in a suitable file format. 

2.3 NVS Express program updates 

 
Periodic updates to NVS Express authority data are needed to update default 
methods and species code lists. Updates will be periodically released from the NVS 
Databank to registered users of NVS Express.  

 Updates will be installed onto local versions of NVS Express via the file called 
‘NVS_AuthorityData.mbd’.  

 Select ‘Import Authority Data’ from the File menu, and navigate to the folder 
in which the updated ‘NVS_AuthorityData.mbd’ file is saved. 

 

2.4 Non-standard methodologies 

 
If you want to enter data that does not find the standard methodology described in 
the Hurst and Allen (2007) manuals please contact the NVS database administrator 
(nvs@landcareresearch.co.nz). There are also options for pre-loading tags for re-
measured permanent plots that can be discussed with NVS staff. 
 

mailto:nvs@landcareresearch.co.nz
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3 Data Entry Workflow 

The following workflow (Fig. 2) should be followed for data entry using NVS Data 
entry. See the relevant sections in this manual for step-by-step instructions for 
undertaking each task. A number of issues are commonly encountered when 
entering vegetation data, of which data-entry operators should be aware. These 
include duplicate tag numbers in stem diameter data (Section 8.3), and 
unrecognised species codes (Section 9). If other issues are encountered that are not 
covered in this manual, contact the NVS Database Administrator for further help. 
 

Save a new project

(enter project name, date etc.)

Enter ‘Party’ information

(Primary contact and field-staff)

Generate plots

(all plots for survey)

Enter data

Export notes

Validate data (export notes to 

assist with checking)

Correct errors

Upload data to NVS

Run post-entry validation

 
 
Fig. 2 Data entry workflow for data entry using NVS Data entry. 
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4 General editing tips 

 Edit Mode: NVS Data entry must be in edit mode before changes can be 
made to data. Select ‘Edit Mode’ using the File menu or toolbar button. If 
options, buttons, etc are greyed out, it’s usually because you are not in Edit 
mode. 

 

 Saving data: Data is not saved as you enter it, only when you click ‘Save’ or 
close a form and save when prompted. 

 Refresh button: Press the ‘Refresh’ button after changing a project name, or 
if changes made are not immediately visible on the screen. 

 Data validation: Data is validated as you enter it and more extensively 
before saving. Warnings and errors are given – data can be saved if there 
are warnings, but not where there are errors. Errors need to be corrected 
in order to save changes made to the plot or project. Where errors can’t 
yet be resolved but the data needs to be saved, record a note highlighting the 
problem so that no information is lost. Either add a plot note or an operator 
note (within square brackets; see details below). The note should have 
details of the data that has been removed so that you can return with the 
correction at a later time. 

 See Section 10 for details of the Validation procedure. 

 

 Recording notes during data entry: Notes can be attached to any object 
being edited (i.e. project, plot, plot observation, project method). Notes may 
be either those recorded by field-staff on the field-sheets, or those recorded 
by data entry operators during data entry (as denoted by square brackets). If 
you hover the cursor over a note you can see a description of the object (eg 
Plot: A1) without having to open the note. 

 

 Adding a note to a project, project method or plot: Use either the 
‘Notes’ tab on the toolbar (to add a note) or select ‘Notes’ from the View 
menu (to also see all existing notes). If a note is entered while in the Site 
Description method it will be categorized under the plot being entered. 
Notes entered in other method screens will be categorized under both 
the particular method and the plot. When adding a note use Shift + Enter 
for a line break, and Enter to exit the note window. 
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 Entering notes recorded on field-sheets: When adding a note to an 
individual observation (e.g. against a species occurrence on the Recce 
Vegetation Description) use the ‘Notes’ column on the far right of the 
data entry form. 

 Data entry operator notes for individual observations: When adding 
an operator note to an individual observation the note is also recorded in 
the notes column. Operator notes should be used to record important 
data quality observations; any assumptions made by the data entry 
operator; and to identify problems that still need resolution. Operator 
notes on data entry forms must be entered using square brackets (i.e. 
[…]) or must be preceded by double question marks (i.e. ??). These 
notations distinguish operator notes from those recorded by field-staff, 
and ensure that these notes will be identified during plot validation 
procedures. 

 

 Remeasurement notes: Notes pertaining to corrections required to 
previous measures of tagged individuals should be entered in the notes 
field beside the stem and enclosed in dollar signs (i.e. $$). See section 
8.3.1 for a detailed description of the situations in which to use these 
types of notes. 

 

 Operator notes for the plot: Notes can be added to the plot, rather than 
to an individual observation on the plot. Notes added to the plot can be 
useful for generic issues relevant to the whole plot (e.g. noting that much 
of the data on the plot sheet was illegible, or that subplot D contained no 
trees or saplings). Plot operator notes do not need to be contained in 
square brackets. 

 

 Viewing notes: Notes for an object can be viewed, filtered, and sorted, 
from the View menu. 

 

 Exporting all notes for a project: Use the ‘Export’ function to extract all 
the notes from an entire project and create a text file. Give the text file a 
logical name – one system is to give it an appropriate abbreviation of the 
project name (up to 6 digits), followed by the year (2 digits; e.g. 
FYFFE07.txt). 
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 Importing notes: Notes can be imported from text files via the notes form. 
This might be useful, for example, to avoid re-entering descriptions of 
modified methods. 

 

 Highlighting potential species code errors: Use a double question mark 
to annotate any valid species code that needs to be double-checked (e.g. 
QUISER??). This will identify the code as an invalid code during data 
validation. (Note: The ?? notation is also used automatically to highlight 
duplicate tag entry; see Section 8.3). 

 

 Dates: Dates are entered and displayed in the year–month–day format (e.g. 
yyyy–mm–dd). For example 5 January 2008 is entered as 2008–01–05. This 
allows partial dates to be entered where the full date is not known (e.g. the 
year only may be entered (i.e. yyyy), or the year and month only (i.e. yyyy-
mm)). 

 Adding and deleting rows within grid tables: In NVS Data entry many 
kinds of data are entered into tables (e.g. disturbance, fauna and ground 
cover records in the Recce Site Observation form, and the Stem Diameter, 
Sapling and Seedling Count forms). When working in tables: 

 

 To add a row: either right-click and select ‘Add…’; or click in the grid 
and hit the Insert key. On some forms rows can also be inserted via the 
Edit menu or toolbar button. 

 To delete a row: either right-click and select ‘Delete…’; or click in the 
grid and hit the Delete key 
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 Sorting grid tables: Data entered into tables can be sorted by the 
values in any column, either in ascending or descending order. To sort, 
click on the column heading. 

 Order of data entry: To get data back into the order it was entered, sort 
by the column (#). 

 Maximise each data entry window: or use the scroll bar on the right of the 
window) to ensure that data is entered in all of the relevant data entry fields. 

 Audit information: The creation/modification date/time and user can be 
observed for any project, plot or individual observation. For project methods or 
plots this information can be accessed via the View menu or the ‘Audit’ toolbar 
button; and for individual observations on plots it can be accessed by right-
clicking and selecting ‘View Audit info’ 

 

 

 

 
 

 Multiple data entry windows open: If preferred, more than one data entry 
window can be open at once (e.g. both the sapling and stem diameter tables; 
or both the site description and the browse table). This allows data to be 
entered in the order recorded on the field-sheet (e.g. where saplings and 
trees are recorded on the same sheet). Resize each window, by holding the 
mouse over the edge of a window and using the mouse to click and drag 
each window to the required size. 

 Compacting the project file: This function should be used periodically to 
improve the performance of NVS Data entry. Select ‘Compact Project File’ 
from the File menu.  
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4.1 Keyboard shortcuts used in NVS Data entry 

 
Tab  Advances curser to the next cell, or if at end of a line inserts a new row 
Ctrl + Insert Inserts a new subplot in grid tables 
Insert  Inserts a new species record in grid tables 
Delete  Deletes the value in a cell. If in a cell identifying a row (such as a tag or 
  species column) then the whole row is deleted. 
 
Alt + F  Opens File menu 
Alt + V  Opens View menu 
Alt + E  Opens Edit menu 
Ctrl + E Enables/disenables edit mode 
Ctrl + S Save current window 
 
Ctrl + N Opens notes to view or add 
Ctrl + L Validate all 
 
F5  Refresh view 
 
Ctrl + A Associate marked stems (in stem diameter data entry window only) 
Ctrl + D         Fill Down function, inserts preceding species in cell or continues tag    

sequence numerically (in stem diameter data entry window only) 
 

 

 Advancing to the next plot: In most data entry tables, advancing to enter 
the same type of data for the next plot is possible without closing and re-
opening any windows. Use the arrows shown at the top right of the window. 
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 Often, as you work through NVS Express, you will find there are alternative 
ways of doing the finer points, usually only one is presented for brevity, but 
feel free to choose an alternative perhaps depending on your preference as a 
keyboarder or mouser. 

 

5 Setting Up a New Project 

5.1 Creating a new project 

 

 To create a new project – Three options, select ‘New Project’ from the File 

menu or the new item menu or click on  .  

 

 

 

 A window will open, asking you to select the methods that your project uses. 
The default selection (displayed below) is for a standard 20m x 20m 
permanent plot.  
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 The method options are: 

 
o Browse: browse information as recorded on a standard Recce 

inventory. 
 

o Grassland Recce: Recce inventory using standard grassland tiers (as 
per Wiser & Rose 1997). 

 
o Percent Cover by Tier: Recce inventory using standard forest tiers (as 

per Hurst & Allen 2007), which allows you to enter actual percentages 
rather than cover scores. 

 
o Recce Inventory: Recce inventory using standard forest tiers (as per 

Hurst & Allen 2007). 
 

o Sapling Count: standard permanent plot quadrat sapling counts (as 
per Hurst & Allen 2007). 

 
o Seedling Count: standard permanent plot quadrat seedling counts (as 

per Hurst & Allen 2007). 
 

o Species List: species list for a plot. 
 

o Stem Diameter: standard permanent plot quadrat tree diameter 
measurements (as per Hurst & Allen 2007). 

 
If you have used another standard method or method variation that you would like to 
enter, please contact the NVS database administrator 
(nvs@landcareresearch.co.nz) for advice. 
 

mailto:nvs@landcareresearch.co.nz
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If you are entering a permanent plot remeasurement, it is possible to be provided 
with a project pre-loaded with stem diameter tag numbers. Please contact the NVS 
Database administrator (email:  nvs@landcareresearch.co.nz) if you would like to 
receive a template project.  
 

 If you are entering anything other than the standard 20m x 20m 
permanent plot it is important to contact the NVS database 
administrator BEFORE you start entering any data. 

 

 Access Level: Choose the appropriate access level for your data from the 
drop-down menu. 

 
o Not Set – A stop-gap while considering the appropriate access level. 

 
o Public – No limitation on availability of data. The provider puts no 

conditions on use of the data. 
 

o Restricted – The existence of these data will be shown on data 
listings, but use is restricted by the provider. Written approval must be 
obtained from the provider before data will be supplied. 

 
o Private – Confidential or commercially sensitive data. The existence of 

data will not be advertised; they will be archived in NVS predominantly 
for data security. 

 

 Enter the project name, description, start date and vegetation type.  

 Name: The project name used should be consistent with the project 
name recorded on field-sheets. This name will be used to identify the 
dataset once the data is archived in the NVS Databank. The name 
used cannot be the same as any existing project you may have 
established in NVS Data entry. If necessary the project name may be 
changed at a later date and the project resaved. 

 Newly established projects: The name used must be distinctive from 
any project names already used in the NVS Databank – see 

https://nvs.landcareresearch.co.nz/ or click on the link on 
the left-hand side of the NVS Data entry ‘Home’ screen. 

 Remeasurements of existing NVS projects: If the project being 
entered was a remeasurement of an existing NVS project, it is 
important to keep the project name consistent across measurements. 
This helps to avoid any confusion in future and provides an intuitive link 
between remeasured projects. Exceptions to this rule may arise if a 
project combines remeasured plots from more than one NVS project, 
or includes newly established plots, or comprises non-standard and 
partial plot remeasurements. In such situations contact the NVS 

mailto:nvs@landcareresearch.co.nz
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Database Administrator (email: nvs@landcareresearch.co.nz) for 
advice. 

 Description: Enter a short description of the project data that will be 
contained in the project. This project description can be useful to 
record any notable features of the project. In particular, it is important 
to record any deviations from standard measurement protocols (e.g. 
documenting that epicormic shoots were counted as saplings), or 
information on the procedure used to collect certain data (e.g. 
documenting that altitude was read from GPS coordinates and a map 
rather than from a barometric altimeter). 

 Start date: Enter the start year (e.g. 2006). The project cannot be 
saved without a valid start date. The start year should be the year that 
the fieldwork for the project began. For further details on entering dates 
see Section 6. 

 Type: Select your general vegetation type from the drop-down list of 
options (Forest, Grassland, Mixed, Other, Scrub, Tussock or Wetland). 

 
 

 Save the project: Click the ‘Save’ toolbar button , or select ‘Save’ from the 

File menu. Once saved, press the ‘Refresh ’  button on the toolbar if the 
project name shown in the ‘Projects’ window has not been updated. 

 Project file: Once saved, each project is stored in a separate file on the local 
disk (e.g. within a folder ‘NVS Projects’ in ‘My Documents’).  

mailto:nvs@landcareresearch.co.nz
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 Deleting a project: A project can be removed from your NVS Express 
by deleting the unwanted project file within the ‘NVS Projects’ folder. 
Alternatively, for the cautious, an unwanted project file can be shifted to 
another location using cut/copy & paste or drag & drop. Ensure that 
important files are backed up periodically until they are completed and 
sent to the NVS Databank for further validation and archiving. 

 The Project Methods  

 Once the new project has been saved, NVS Data Entry will create the 
methods applicable for the project. The default set of methods are 
those associated with a standard 20 x 20m forest plot.   

 Details of the Site Method and Site Observation methods, equivalent to 
the front side of the Recce description field-sheet, are in the box at the 
bottom of the screen.  

 To examine details of the Sample Methods (including Browse (i.e. 
browse data recorded on the Recce Inventory sheet), Recce Inventory, 
Sapling Count, Seedling Count and Stem Diameter) click on the node 
to the left of the project name in the Projects box, then click on the 
method of interest, method details will appear in the box at the bottom 
of the screen. 

 To view the details of each method, Use the ‘+’ symbol next to the 
aspect (node) that you want to view or, use the numbers 1–6 to view 
more or less detail under each node; note that this function only 
operates to expand nodes that have previously been expanded 
manually (as above). The * symbol expands each node fully to display 
all available detail. For the node headings that are listed in bold font, 
the same level of detail may also be viewed in a separate window by 
double-clicking on the heading. 

 

 Check the default ‘Project Methods’: It is very important that any variations 
to the project methods for the current project are identified and documented. 
For example, the default option for altitude measurement is to use an 
altimeter (see screen-shot below). If the field-team instead read altitude from 
a map, then this deviation should be added as a project or plot-level note2 
(see Section 6 for more info on adding notes). Please also include this 
information in the metadata you send in. When the data is uploaded to the 
NVS databank, the administrator will ensure that the Project Methods are 
adjusted to accommodate such variations in methodology.  

                                            
 
2 ‘Survey notes’ should be used to document details that are consistent across all or 
most of the plots in a project; ‘Plot-level notes’ should be used to describe details 
pertaining to an individual plot. 
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 Non-standard additions to methods: Note that the standard Project 
Methods cannot be changed in NVS Data Entry. If your project used non-
standard methods or contains additional methods (e.g. Foliar Browse Indices 
on plots), use a note (see Section 6) to document the method variation or the 
existence of additional data; and contact the NVS Database Administrator 
(email: nvs@landcareresearch.co.nz) for advice on entering or archiving the 
additional data. 

 If, after adding the methods, you discover that you have not added all of the 
methods measured in the project you can still add additional standard 
methods. Turn edit mode on, right-click on the project name, and then click 
on ‘Select Project Methods’ and add further methods from the list. These 
methods are applied to existing plots as determined by their Automate 
settings. 
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5.2 Entering party (person & organisation) information 

A Party, in NVS Express, can be a person or organisation. Party information is 
entered against the whole project (e.g. primary contact person) and for each 
individual method (Recce Inventory, Stem Diameter etc) on plots within the project 
(e.g. measurers & recorders). The party information gets saved to a file on your 
computer so in future projects, if the same parties are involved, you can simply add 
them instead of re-entering their details. 
 
NVS Party Sharing 
 
NVS Express can Export all parties associated with a given project or set of projects, into a 
party file. NVS Express users working with the same parties (in the same organisation but 
not on a shared network) can exchange lists using the Export and Merge functions so they 
donôt have to re-enter all party details and to avoid duplicate parties being uploaded to NVS 
DB. Also, NVS Express users working on a network (in the same organisation) can use a 
single, shared party file. To do this, an existing party file (such as the NVS Std parties) is 
placed in a shared location then each user Joins it, which copies all their parties into the 
shared file. Whenever party lists are joined there is the possibility of creating duplicate 
names, In the case of people, surname and email are used to match parties so the entering 
of an email for each person should be encouraged. 

 
5.2.1 Enter details for whole-project Parties 
 

 Click on the project name in the left-hand frame then the ‘Parties’ tab to open 
the window in which to enter parties involved with the project. 

 

 Click on Edit Mode to enable editing. 

 When you first use NVS Express you will need to populate your own Party 
Data ‘database’, once parties are in your ‘database’ you can search for them 
and add them straight into the ‘Party’ field. To create a new party record, 
right-click in the grey space in the Parties window and choose New Party. A 
New Person form will appear. 
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 New Person 

 Enter the person’s name and contact details. For each type of contact 
information you can have multiple current options (e.g. a home phone 
and an office phone) but only one preferred option. Fill in as much 
information you deem is necessary. Save. 

 Organisation 

 To create an Organisation associated with the person, click the ‘New’ 
organisation icon. Be aware that you open up a second window. If you 
are adding new organisation(s) we recommend that you do this before 
you start adding people. 

 Position 

 You can also create a position within an organisation by clicking the 
‘New’ icon. 

 Once Person, Organisation and Position details are saved in your NVS 
Express, you can add them to subsequent projects by simply choosing Add 
Party and searching for the desired person, organization or position when 
you right-click within the Parties tab. 

 Once you have added the Party, you should assign that party a role. Click in 
the ‘Role’ field and choose the appropriate role from the drop-down menu.  

 Enter the organisation(s), if any, that the project is associated with. In the 
Organisations window right-click under the ‘Party’ and select ‘Add Party’. A 
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Select Party box will come up - if you have added organisations they will be 
listed here. If you have not added any organisations click the ‘New Party’ 
drop down list and select ‘Organisation’ drop down menu and select 
‘Organisation’. 

 Fill in the details for an organisation. You can also associate people and 
positions to an organisation, similar to associating details with a person. 

 

5.2.2 Enter parties for each method 
 

Open the project header in the left hand frame to reveal each method used in 
the project. Click on the method (in this case Recce Inventory) and enter each 
party involved in the recce (this should be recorded on the plot sheets). You 
can either create new parties as in 4.2.1 or, if already created, add them from 
the drop-down list. The whole list appears for the first entry, and the list is 
‘populated’ as you choose each new person from the ‘(All people)’ option. 
Don’t forget to assign a role for each party you include. If you enter a person 
by mistake, you can right-click & delete. 
 

 

 

Save after each method is populated and repeat the process for each method 
used in the project.  

 

 People and party information can also be accessed and edited within 
the site description window for each plot. This is where the party details 
are entered for the site measurements recorded on the front page of the 
Recce plot sheet: This includes the names of the people who measured the 
plots, the organisations that employ them and their position and contact 
details. This information will often be the same or similar for many plots within 
a project, so it is usually most efficient to enter all party details in the plot 
template (refer Section 3) before starting to enter plot data (although 
additional people or organisations can be added whenever necessary). To 
enter the plot measurer or recorder: 

 To record who did the measuring and recording of the site description, from 
the plot ‘Site Description’ window, click on the ‘Measurer/Recorder’ drop 
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down list to select a person you have previously created (or create a new one 
by right-clicking & choosing ‘New Party’), and the ‘Role’ drop down list to 
assign them their role (i.e. either the measurer or recorder) as recorded on 
the plot fieldsheets). 

 To record who was on the project team as a whole and their roles (which may 
be multiple), fill in the ‘Team’ list. 

 

 If the desired person is not listed, create a new person by using the ‘New 
Party’ toolbar button in the ‘Add Party’ box and selecting ‘Person’. 

 A new window will open. Fill in the details for the new person as described on 
page 17. 

 

 Measurers and recorders can also be added to each method on the 
plots. To do this you need to be in the method data window for the plot and 
click the button ‘Show Header’. This is best done at the time of entering the 
data. 

The header will then be displayed, which includes party information. Ensure 
Edit Mode is turned on. Right-clicking in the ‘Party’ box and selecting ‘New’ 
or ‘Add’ will bring up the ‘Select Party Role’ box discussed earlier and you 
can enter the individuals who measured and recorded the data for this 
method on the particular plot.  

 

6 Setting Up a New Plot Within a Project 

 Edit mode: NVS Data entry must be in edit mode before changes can be 
made to a project. Select edit mode using the File menu or by clicking the 
‘Edit Mode’ button on the toolbar. 
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 Add a plot to the project. To add the first plot you can either click the ‘Plots’ 
tab and click on ‘New Plot…’ or select ‘New Plot’ from the drop-down menu.  

 When ‘New Plot’ is chosen a new window will open, the Site Description 
page (see Section 7 below), this is where the plot observation data for the 
plot will be entered. This identifies the plot, its location and site observations 
(generally equivalent to the data recorded on the front side of the Recce 
description sheet). 

 Enter the Plot Name (e.g. Exclosure 1) and save, the program will ask about 
generating plot methods and subplots, click OK and OK again. 

 Close the Site Description window and note the ‘New Plot…’ has become 
‘Exclosure 1’ (or whatever you called the plot). Click on the + sign to reveal 
the items mentioned in the automate box on saving. 

 

 

 For more information on creating plots which are not 20m x 20m, see 
section 7.  
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 Entering other method data: NVS Express allows data to be entered and 
viewed in two different layouts once the plots have been created. The ‘Plot 
Observations’ node displays the data grouped by plot whilst the ‘Plot Method 
Data’ node shows data grouped by method.  

 

Plot Templates - A time saver 

 You can either create a New Plot from scratch every time, which may be time 
consuming or we suggest you create a plot template. 

 Creating a plot template: A time-saving plot template can be created so that 
data that will be the same for all plots in the project can be entered just once. 
For example, if the same GPS receiver, datum and map series is used 
throughout the project, then this data can be entered in a plot template and 
any new plot copied from this will have this information automatically filled in.  

 To set up a plot template, enter a plot name, e.g. ‘Template’, in the Plot 
Name field, and any other data which will be the same for all plots in 
this project (and not already defaulted).  

 When you save the plot, an Automate box will appear detailing the 
items automatically generated for your project. Click OK. 

 Copying the plot template: To create further plots right-click on the 
templateôs name (in this case, óTemplateô) and choose óCopy plotô. Another 
Site Description page will appear, this template copy will have the fields filled 
in as for the template. Type in the plot name (in this case, óExclosure 1ô), 
save and close. 

 

 Back on the Plots tab, the new, copied plot will have appeared. 
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 When copying plots, always check the data carefully to ensure that all data 
for the new plot has also been copied. 

 
 

7 Entering Site Description data (Recce site description) 

 Site description data (Site data) is generally equivalent to the data recorded 
on the front side of the Recce field-sheet. 

 Opening the form: To enter site description data, double-click on ‘Site 
Description’ (or right click & choose ‘Open Site Description’) under the plot 
name in the Plots tab.  The Site Description page will open to fill the screen.  

 Default values: If the plot was created from a plot template (see Section 4), 
then some of the cells within the Site Description will be filled in. Make sure 
that the pre-filled information is correct. 

 Is the plot permanent? This checkbox has three states: Yes (tick), No 
(blank), and Unknown (blocked out in grey). If the site description is for a 
permanent plot, click the ‘Permanent’ box to display a tick and identify the 
plot as permanent if the plot is a 20x20-m permanent plot. Once ticked, four 
default rows are added to the plot layout for entering the measured plot 
dimensions. 

 Missing data: Record a note for the plot (see Section 6) noting any data that 
is missing. Missing data will be highlighted in the data validation functions – 
the notes will enable a quick check that the data was missing on the field-
sheet, rather than missed during data entry. 

 Plot Name: Enter the unique plot identifier for the project, as recorded on the 
Recce field-sheet. When entering the plot name for plots that were located on 
transects, follow the standard system by entering the line number, followed 
by a space, followed by the plot number (e.g. line 20 plot 1 is entered as 20 1 
(not 20/1 or 20-1 as this can cause confusion such as being regarded by MS 
Excel as a date). If the plot was a remeasurement from a previous project, 
ensure that the plot name remains consistent in the archived electronic data 
of each project. This allows the lineage of the plot to be readily identified 
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when the data is uploaded to the NVS Databank. If the correct plot name 
used in the archived electronic data is unknown, contact the NVS databank 
administrator.  

 Current name: This field is only used where a plot has been renamed 
between different project remeasurements (as can happen if a new project 
includes remeasurement of plots from many different historical projects). Only 
enter data here if necessary. Where nothing is entered the value defaults to 
the plot name. 

 Location: Enter the sub-catchment, catchment and region as recorded on 
the field-sheet, separating each with commas (e.g. West Coast Conservancy, 
Whitcombe River, Vincent Creek). 

 Treatment: If the plot is a fenced ‘exclosure’ or associated ‘control’, please 
select these options from the drop-down list. The option of ‘normal’ can be 
selected to indicate that there was no treatment applied to the plot. If you 
have other types of plot treatment you can use the options ‘treatment’ and 
‘non-treatment’ and specify what these treatments are in a project note (see 
Section 6). 

 Placement: The sampling method by which plot locations were decided can 
be classed as either subjective or objective. The options are:  

 Subjective:  

 
o Targeted: (also referred to as ‘preferential’ or ‘selected’): professional 

judgment is used to select plot locations deemed to be appropriate to 
the study. 
 

o Key area: locations for sampling are representative of either a larger 
area e.g. a beech forest on a ridge or of critical areas (e.g. high impact 
sites or locations where rare species occur). 
 

o Haphazard: samples are collected in the field without any pre-
determined method for deciding where to sample. In essence, this 
approach is the de facto method when no other method was used. 

  

 Objective: 

 
o Simple random: all of the sampling units are enumerated and a 

specified number of sampling units are selected at random from all the 
sampling units. Each sampling unit has the same likelihood of being 
selected and the selection of one sampling unit does not influence the 
selection of any other sampling unit. Simple random selections are 
easy and fast to implement using a variety of GIS, statistical or 
spreadsheet programs. 
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o Two-Stage Sampling: The area is divided into primary sampling units.  
The primary sampling units to be sampled are selected randomly. Then 
a secondary selection of plot locations is made within the primary 
sampling unit.  These secondary locations can be random or 
systematic.  This was the plot location method primarily used by the NZ 
Forest Service in historic vegetation projects using the 20x20-m plots. 
 

o Stratified random: Stratification is the process of dividing a set of 
sampling units into one or more subgroups (i.e., strata) prior to 
selection of plot. Plots are then selected randomly within each stratum. 
The purpose of using stratification is to account for variability in a 
population that can be explained by another variable (e.g. vegetation 
type, aspect, soil type, etc). 
 

o Restricted random: the area to be sampled is divided up into large 
segments based on the number of plots needed. Within each segment, 
a single plot sampling location is selected at random. 
 

o Systematic: plots are located within an area according to a regularly 
repeating pattern. Examples of systematic sampling are: locating 
sample sites on a 1km grid within a pasture, taking measurements 
every meter along a transect or orienting transects along cardinal 
directions. 
 

 Party data: Add persons involved in the plot description (Measurer/Recorder) 
and persons and parties involved in the plot as a whole (see Section 4). 

 Plot layout: Enter the plot layout data (bearings and tape lengths). When 
‘Plot’ is validated, all layout tape distances are validated against the 
‘conceptual’ plot size (see below) and a warning is given if they are more 
than 25% above the longest or 25% below the shortest side. 

 Plot Shape: Choose plot shape from the dropdown list. The default shape is 
square. 

 Size: The size of a standard permanent plot is 20×20-m square. The values 
entered in this field represent the ‘conceptual’ plot size (i.e. not accounting for 
minor deviations in tape length that are entered in the plot layout fields 
above). 

 Plots of non-standard sizes: Square plots of other sizes may be 
entered so long as their dimensions are multiples of 5 m (e.g. 10×10 m, 
20×30 m). To change the plot size, edit the values and press the 
‘Calculate’ button. When you save the plot NVS Data entry will then 
automatically generate enough standard-sized subplots (e.g. 5×5 m) to 
fill the plot area. 

 Plots of other non-standard sizes or shapes: NVS Data entry is 
unable to automatically generate subplots for plots of other non-standard 
sizes or shapes. In these cases subplots must be manually generated 
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when the plot is created. If you need to do this please contact the NVS 
database administrator for advice beforehand 
(nvs@landcareresearch.co.nz). 

 Altitude: Enter the altitude in meters above sea level (a.s.l.), or, if the precise 
altitude is unknown, enter the potential possible range. 

 Physiography: Use the dropdown list to select the recorded option. If what is 
recorded does not conform to any of the listed entries, record it in a note for 
the plot (see Section 6). 

 Aspect: Enter the aspect in degrees, or if recorded as such, compass 
direction. If there is no aspect (i.e. where a plot is flat) leave this field blank. 

 Slope: Enter the slope in degrees. Slope is normally measured using a 
clinometer, the method specified in the default project methods (see Section 
4). If the slope was estimated, or measured using some other procedure, use 
a plot note (see Section 6) to record the deviation from the standard 
measurement methods. 

 Shape: The landform shape of the plot. Use the dropdown list to select the 
recorded option. If what’s recorded isn’t in the list, record it in a note for the 
plot. 

 Parent material: Enter the parent material if it was recorded in the field. 
Common options are included in a dropdown list. If what’s recorded isn’t in 
the list, record it in a note for the plot. 

 Soil drainage: Use the dropdown list to select the recorded drainage class. If 
what’s recorded isn’t in the list, record it in a note for the plot. 

 Cultural/disturbance: Select a disturbance type (where recorded) from the 
dropdown list. Add a comment if one has been recorded on the plotsheet. To 
add a row in the disturbance box right-click in the box and select ‘New 
disturbance’. Ensure that only one record is entered for each category of 
disturbance. 

 Approach: Enter the approach notes recorded for the plot. 

 Notes: Plot-specific notes can be entered by using the ‘New note’ button on 
the top ribbon or by using the ‘View notes’ button beside the ‘Approach’ box.  

 For exclosure plots there are some separate categories of notes to 
record details of the condition and history of the fencing. Using the ‘View 
Notes’ button, select ‘New note’ and then select the category ‘Fence 
condition’ to enter notes on the condition of the exclosure fence. Under 
the ‘New Plot note’ option you can select ‘Date Fence Build’ and ‘Date 
Fence Inspected’ categories for notes. 

 Fauna: To add a row in the Fauna box, right-click in the box and select 
‘New’. Use the dropdown menu to select the fauna type (i.e. mammal, bird, 

mailto:nvs@landcareresearch.co.nz
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reptile, invertebrate, marsupial or amphibian); then type the name (either 
common or scientific) of the fauna observed. A description or additional 
information can be added where appropriate. 

 Start date: Enter the date recorded on the field-sheet (in the format yyyy-
mm-dd; see section 6 for information on entry of dates). 

 Stop date: The default ‘Stop’ date is the same as the ‘Start’ date and this is 
automatically generated. If the plot was completed over more than one day, 
delete the automatically generated date (using the delete or backspace keys) 
and enter the correct stop date. 

 Absolute coordinates: Select the methods used to derive the plot location 
coordinates. In most instances this will be: 

 Grid coordinates: in meters (m) 

 Method: GPS 

 Datum: NZGD49 (or NZGD2000) 

 Projection: NZMG (or NZTM2000) 

 Map: Select the map series and map sheet number. 

 GPS: Select the appropriate make and model of GPS receiver, and enter the 
precision of the fix. If your GPS model is not in the list please add a note 
listing the unit used. This is helpful in assessing how accurate the reading 
may be. 

 Coordinates: Enter the coordinates of the plot. In most instances these will 
be in seven-figure map grid coordinates. Only enter the precision of the 
Easting and Northing if this information is known. 

 Mesoscale topographic index: Enter each horizon angle, ensuring that the 
sign of each angle (+/–) is correctly entered. 

 Surface characteristics: Enter the percentage of ‘Surface bedrock’ and 
‘Surface broken rock’. If none was present, enter a zero (i.e. ‘0’). Where data 
was not recorded on the field-sheet, delete the entire row, by right-clicking on 
the row and selecting ‘Delete surface’. Additional non-standard categories, 
which may be added where applicable, are ‘Surface rock’ and ‘Surface 
charcoal’. Ensure that each category of surface characteristic is entered only 
once. 

 Size of broken rock: Select the applicable size (i.e. either less than (<)30 
cm or greater than (>) 30 cm diameter). NVS Data entry will also allow both 
categories to be selected, in case a non-standard method was used. 

 Ground cover: Enter the percent cover for each of the standard ground 
cover categories listed on the field-sheet (‘vegetation’, ‘non-vascular’, ‘litter’, 
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‘bare ground’ and ‘rock’). If none was present, enter a zero (i.e. ‘0’). Where 
data for any category was not recorded on the field-sheet, delete the entire 
row by right-clicking on the row and selecting ‘Delete Ground Cover’. To add 
a row, right-click in the grid and select ‘New Ground Cover’. Ensure that each 
ground cover category is entered only once. Additional non-standard 
categories can be selected using the dropdown list and these may be used 
where applicable. 

 Average Top Height: Enter in the appropriate field in units of m. 

 Canopy Cover: Enter in the appropriate field in units of %. 

 Save the Site Description data and deal with any validations. 

  

8 Entering Plot Methods data (vegetation data) 

All plot method data, including the Recce vegetation description, browse, stem 
diameter data, sapling counts and understory subplot data, is entered for one 
method and one plot at a time, one row per plot and species (or individual). 
 

8.1 Browse 

 Open a Browse form: In the Projects list, open the node of the project you’re 
working on to reveal the methods list of that project, click on ‘Browse’. The 
Browse method will appear in the Plots tab. Double click on the plot name to 
open the browse data entry form for that plot. This is where the browse data 
recorded on the front side of the Recce vegetation description sheet is 
entered. 

 Click on ‘Edit Mode’ button to enable editing. 

 Adding species: Click on the ‘Add Species’ button on the toolbar, or press 
the Insert key on your keyboard. 
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 Species codes: Enter species codes in the ‘Verb. Code’ column. Either enter 
the full six-letter code, or select the correct code from the dropdown list. For 
further information on species codes, see Section 9. 

 Browse: Begin typing the relevant browse Severity (low, medium or high). 
Select the Herbivore by starting to type the name or by using the dropdown 
lists that appear. If OK, click OK. 

 
 

 Herbivore not in the list? If the relevant browser is not in the pre-populated 
list, use the notes column to add the herbivore. 

 Deleting rows: To delete a row, right-click on the row and select ‘Delete 
Browse Species’ or click on the species code or full name and hit the Delete 
key. 

 

8.2 Recce Inventory 

 Open a Recce Inventory form: In the Projects list, open the node of the 
project you’re working on to reveal the methods list of that project, click on 
‘Recce Inventory’. The Recce Inventory method will appear in the Plots tab. 
Double click on the plot name to open the Recce Inventory data entry form 
for that plot. This is where the Recce data is entered. 
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 Click on ‘Edit Mode’ button to enable editing. 

 Show Header: Click ‘Show Header’ on the top tab to open a header where 
party data can be entered i.e. the names of the people measuring and 
recording this data. See section 4.2 for further detail. Once parties have been 
added, click ‘Hide Header’ to toggle back. 

 Edit/delete height tiers: For ease of data entry and to avoid errors, you can 
remove any tiers not used for the particular plot. Do this in the Recce Tier 
details page. Click on the unwanted tier in the (Recce Tier) list and click the 
Remove Tier button (or, right-click on the tier to remove, and select ‘Delete 
row’). Note the removed tier is placed in a ‘Re-insert removed Recce Tier’ 
drop-down list in case you find you do actually want to use that tier. To 
reinsert a tier, double-click on the tier in the drop-down list. If you hadn’t 
saved the data, a warning message will appear prompting you to do so 
before that tier can be reinstated. 

 Lower and Upper Heights: If different from the standard range, enter those 
here. 

 Cover Class: Enter each cover class score, choose from the drop-down list. 
Where vegetation was present, yet no overall cover class score was recorded 
use ‘P’ to indicate the presence of vegetation in that tier. 

 Sorting tiers and columns: Open the Recce Species tab and, for 
convenience, drag and drop any removed tiers (whose labels will now be in 
brackets) to the far right-hand side of the Recce Species form. 

 Adding species: Click on the ‘Add Species’ button on the toolbar, or press 
the Insert key on your keyboard. 

 Enter data: Fill in data columns, using the Tab key to move across each row 
(and the cursor keys to move down or up). Each tier cell has a drop-down list, 
or just enter the value. As an alternative to having to keep clicking the ‘Add 
Species’ button, as you tab across off the end of a row, a subsequent row will 
automatically be added. 



       
 

Landcare Research 

35 

 Species codes: Enter species codes in the ‘Verb. Code’ column. Either enter 
the full six-letter code, or select, by double clicking, the correct code from the 
resulting drop-down list. Both duplicate codes and codes not on the 
dropdown list may be encountered – see Section 9 for instructions on dealing 
with these situations. 

 

 
 

 Deleting rows: To delete a row from the table, right-click on the row and 
select ‘Delete Recce Species observation’. 

 Enter each cover class score in the appropriate tier: The default cover 
class system in NVS Express is the one described in the Hurst & Allen (2007) 
field manuals.  Accepted values are the numeric values of 1–6 and P. These 
represent the following cover classes: 

Cover class  % Cover   
1 <1 
2 1-5 
3 6-25 
4 26-50 
5 51-75 
6 76-100 

P        present, but cover unknown 

Should you have used a different cover class system please contact the 
NVS administrator (nvs@landcareresearch.co.nz) for advice. 

 Changing or deleting cover class scores: To change a cover class score, 
select the cell and type the correct score. To delete a cover class score, 
select the cell and press the Delete key. 
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 Missing cover class scores: Occasionally field-staff may have recorded a 
species code, but not assigned a cover-class score. Here, enter a ‘P’ to 
indicate the presence of the species.  

 Changing column widths: Column widths too wide or narrow? Hover the 
cursor over the edge of the column, then click and move the cursor to change 
the column width (exactly like changing column widths in Excel). Changes to 
column widths and positions are retained between sessions of NVS Express 
data entry. 

 Reordering columns: Do this by clicking on the column name and dragging 
it across to a different position (rather similar to moving cells around in 
Excel). Display of the species name column can be switched on and off using 
the View menu (select ‘Display Species Name’). 

 

 
 

 Sorting the table: Data entered into a Recce table can be sorted by any of 
the headings. For example, to sort by cover class click on the ‘Tier’ at the top 
of the column to sort either by ascending or descending values. To sort data 
in the order it was entered, sort by the order of entry column (labelled #). 

 Data errors: Errors will be highlighted during data entry and error messages 
will be shown temporarily in the status bar. Error messages can also be 
viewed by moving the cursor over the invalid cell. See Section 10 for further 
information on data validation. 

 Non-standard Recce height tiers: The standard Recce height tiers cannot 
be modified in NVS Express data entry. Note that there are a different set of 
tiers in the two different Recce methods: ‘Recce Grasslands’ and ‘Recce 
Inventory’. Contact the NVS Database Administrator 
(nvs@landcareresearch.co.nz) if height tiers used on the plot differ from the 
standard tiers shown. Record the discrepancy as a note for the plot (or 
the project, if applicable). 

 Data validation: If you wish to see a list of warnings or errors part way 
through entry of Recce vegetation description data, click on the ‘Validate All’ 
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toolbar button (or use the keyboard shortcut of Ctrl + L). This function is also 
called automatically when you save or exit. 

 Advancing to the next plot: Arrows on the right-hand of the screen switch 
between plots on the project. Ensure that each Recce vegetation description 
is entered for the correct plot. 

 

 
 

8.3 Stem Diameter 

 Open the stem diameter form for a plot: In the Projects list open the node 
of the project you’re working on to reveal the methods list. Click on ‘Stem 
Diameter’. The ‘Stem Diameter’ method will appear in the Plots tab. Double-
click on the plot name to open the data entry form for that plot. This is where 
the diameter data is entered. 

 Click on ‘Edit Mode’ button to enable editing. 

 Show Header: Click ‘Show Header’ on the top tab to open a header where 
party data can be entered i.e. the names of the people measuring and 
recording this data. See section 4.2 for further detail. Once parties have been 
added, click ‘Hide Header’ to toggle back. 

 Insert a subplot: For the stem diameter data, which is measured by subplot 
(labelled A–P), the form has a ‘Remaining Subplots’ list. To add the first row 
for the next remaining subplot, click the ‘Add Sub Plot’ toolbar button. To add 
the first row for a subplot other than the first in the list, select the required 
subplot from the ‘Remaining Subplots’ list.  

 

 
 

 Inserting more rows for a subplot: To add more rows for the current 
subplot, hit the Insert key, use the Edit menu and select ‘Insert Stem species’ 
or click the ‘Insert Stem species’ toolbar button. 
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 Species codes: Enter species codes in the ‘Verb. Code’ column. Either enter 
the full six-letter code, or select the correct code from the dropdown list. If the 
species to be entered is the same as the preceding species you can use the 
‘Fill Down’ function by either right-clicking and selecting ‘Fill Down’ or by 
using Ctrl + D. For further information on species codes, see Section 9. 

 

 
 

 Tag number: In the Tag column, enter the full tag number of the tree stem. If 
unsure of the correct tag number for a tree stem (perhaps the writing is 
illegible) the problem can be highlighted using ‘??’ after the tag number (e.g. 
AB1234??). This will be identified in data validation procedures allowing the 
value to be rechecked. If the tag numbers are numerical you can use the ‘Fill 
Down’ function to insert the next tag in the series by either right-clicking and 
selecting ‘Fill Down’ or by using Ctrl + D. 

 Duplicate tags: If two entries are made of the same tag number, a window 
will appear highlighting the issue and asking whether to edit the first tag 
entered, flag the tags as duplicates, or edit the last tag. First, recheck the tag 
numbers you have entered against the field-sheets to ensure they really are 
duplicates and were not just misread. If the first tag entered was misread or 
misentered and needs editing, click ‘Yes’, and you will be taken back to the 
first tag to edit it. If the second tag entered was misread or misentered and 
needs editing, click ‘Cancel’ and edit the tag number. If the tags really are 
duplicates, click ‘No’. The duplicate tags will then both be highlighted, and an 
automatic note generated in the notes column. Duplicate tags will be listed as 
warnings when the data for the plot is validated.  
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 Diameter: Enter the diameter of the tree stem in centimeters (cm). If unsure 
of the correct diameter for a tree stem (perhaps the writing is illegible) the 
problem should be highlighted by entering an operator note (see Section 6). 
This will be identified in data validation procedures allowing the value to be 
rechecked and/or identifying the problem for future plot measurements. 

 Heights: Enter the height of the stem (if recorded) in meters (m). 

 Living status: Usually this will be ‘Alive’. On remeasured plots, stems may 
also be ‘Dead’ (where recorded dead on the field-sheet), ‘Not found’ (where a 
note was recorded indicating this on the field-sheet) or ‘Unknown’ (where no 
note was recorded). Use the dropdown list to select the appropriate stem 
status. 

 Associating stems: Stems that have one of four relationships can be 
associated: bracketed, epicormic, epiphytic and fused stems. Stems are 
‘associated’ with one another in the ‘Assoc’ column. If they are the same 
individual and bracketed on the plot sheet they should be listed as bracketed 
(the majority of cases). Epicormic branches arise from previously dormant 
buds along the main stem or branches. Fused stems occur when two tagged 
individuals have grown together and can no longer be measured separately. 
Both stems should be entered but the fused diameter should only be entered 
against one of the stems. Epiphytic stems can also be associated with the 
tree they are growing on, as long as none of the stems are already 
bracketed. Only one relationship can be specified and bracketing should be 
done in preference to epiphytes.  
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The process to associate stems is as follows: 

o Right-click in the ‘Assoc’ column of the stem to be associated and select 
‘Mark or Unmark for Association’ or type an asterix (i.e. *) in the column. 

o To associate the marked stems, right-click and select ‘Associate Marked 
Tags’. Once associated, the stems are assigned a common association 
number which appears in the ‘Assoc’ column. 

o Further individuals can then be associated with these stems by entering 
the association number directly in the ‘Assoc’ column. 

o The default association type is ‘Bracketed’ but you can change this to 
‘Epicormic, ‘Fused’ or ‘Epiphyte’ by choosing from the drop-down list in 
the ‘Assoc Type’ column if required. 

 

 
 

 Subplots with no tree stems present: To indicate that a subplot was 
measured but had no stems present, enter a row for the subplot and the code 
“NOSPEC” in the species code column. 

 Changing the subplot field: If data was mistakenly entered for the incorrect 
subplot, click on the subplot observation you want to change and then click 
the arrow to open the drop down menu and select the correct subplot for that 
observation. 

 Height: Tree height can be recorded if measured. 

 Current Tag: This is only used when a remeasured tree has been retagged 
with a different number. 

 Data validation: If you wish to see a list of warnings or errors part way 
through entry of stem diameter data, click on the ‘Validate All’ toolbar button. 
This function is also called automatically when you save or exit. Use the 
numbers 1–6 to view more or less detail under each method and subplot. 

 Advancing to the next plot: When all of the stem diameter data for the plot 
has been entered, save the data, deal with any validations and either go 
directly to the next plot (click the forward arrow or use the View menu) or 
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enter other types of data for the current plot. Ensure that all data is entered 
for the correct plot number. 

 
8.3.1 Entering stem diameter data for remeasured permanent plots 
 
It is now possible to be provided with a project pre-loaded with tag numbers. Contact 
the NVS Database administrator (email: nvs@landcareresearch.co.nz) if you would 
like to receive template diameter forms.  
 
A number of common data-quality and inconsistency issues occur during the 
remeasurement of permanent plots, especially in stem diameter data where the fates 
of individually tagged stems are followed over time. Corrections to stem diameter 
data from previous plot measurements needs to be undertaken carefully to ensure 
that the data may be used for the intended purposes. 
 
Standard ways of dealing with some common issues in stem diameter data are 
described below. Please use the standard notations so that changes to historical 
datasets can be processed once the data is uploaded to the master NVS database. 
If problems are encountered that are not on this list, please contact the NVS 
Database Administrator (email: nvs@landcareresearch.co.nz). 
 

 Tag corrections: It is essential that tag numbers for individual trees are 
consistent through time so that the fates of trees can be accurately followed. 
Corrections to tag numbers may be necessary where the full tag number was 
not entered into the data for previous measurement, or where a tag was 
misrecorded. 

 Enter the corrected tag number into the tag field, and record the old tag 
number in the notes column. Please use the standard notation of “$” to 
isolate each note in the notes column, in the format “$Tag corrected from 
XXX$”. 

 For example, if a WEIRAC with the tag number E128 was incorrectly 
recorded as E123, then you should enter the stem as WEIRAC E128 with the 
following comment in the notes: $Tag corrected from E123$. 

 Retagged stems: Occasionally stems are given new tag numbers during a 
plot measurement. Please note that retagging with new tag numbers is not 
recommended – a dymo with aluminium tape should be used in the field to 
ensure that a replacement tag can be generated using the original number 
(see Hurst & Allen 2007).  

 Enter the new tag number into the tag field and record the old tag number in 
the notes column. Please use the standard notation of “$” to isolate each 
note in the notes column, in the format “$Retag of XXX$”. 

 For example, if a WEIRAC with the tag number E123 has been retagged with 
tag number AB9876 then you should enter the stem as WEIRAC AB9876 
with the following comment in the notes: $Retag of E123$. 

mailto:nvs@landcareresearch.co.nz
mailto:nvs@landcareresearch.co.nz
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 Re-identification of tagged individuals: Tree stems may have been 
misidentified in the previous plot measurement. These need to be noted to 
provide documentation of which of the alternative species names is correct 
for the tree stem, and so that the old data can be corrected. 

 Where a stem has been re-identified as a species that is different to what 
was previously recorded, enter the correct (new) species code into the ‘Verb. 
Code’ field, and record the old (incorrect) species code in the notes column. 
Please use the standard notation of using “$” to isolate this note and 
recording in the format “$ReID from XXX$”. 

 For example, if a WEIRAC with the tag number E123 has been re-identified 
as a MELRAM, then you should enter the stem as MELRAM E123 with the 
following comment in the notes: “$ReID from WEIRAC$”. 

 Changing the subplot of tagged individuals: In previous measurements 
the subplot for a tree stem may have been incorrectly recorded or entered. 

 Where a stem has been recorded in a different subplot from what was 
recorded previously, enter the new subplot into the ‘Subplot’ field and record 
the old subplot in the notes column. Please use the standard notation of 
using “$” to isolate this note and recording in the format “$Subplot corrected 
from XXX$”. 

 For example, if a WEIRAC with the tag number E123 has been found in 
subplot A rather than subplot H, then you should enter the stem in subplot A 
with the following comment in the notes: “$Subplot corrected from H$”. 

8.4 Sapling Count 

 

 Open the saplings form for a plot: In the Projects list open the node of the 
project you’re working on to reveal the methods list. Click on ‘Sapling Count’. 
The ‘Sapling Count’ method will appear in the Plots tab. Double-click on the 
plot name to open the data entry form for that plot. This is where the sapling 
data is entered. 

 Click ‘Edit Mode’ button to enable editing. 

 Show Header: Click ‘Show Header’ on the top tab to open a header where 
party data can be entered i.e. the names of the people measuring and 
recording this data. See section 4.2 for further detail. 

 Inserting subplots: As this method is measured by subplot (named A–P), the 
form has a ‘Remaining Subplots’ list. To add the first row for the next 
remaining subplot, click the ‘Add Sub Plot’ toolbar button. To add the first row 
for a subplot other than the first in the list, select the required subplot from the 
‘Remaining Sub Plots’ list. 
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 Species codes: Enter species codes in the ‘Verb. Code’ column. Either enter 
the full six-letter code or select the correct code from the dropdown list. For 
further information on species codes, see Section 9. 

 Sapling count: Enter the number of saplings in the ‘Sapling Count’ column. 
If no presence or count has been recorded against a sapling species, enter a 
P for presence, and record a note (using square brackets to indicate that it is 
an operator note) in the notes field (e.g. “[NO COUNT RECORDED]”). 

 Inserting rows: To add subsequent rows for the current subplot, click the 
‘Add Species’ toolbar button. 

 Subplots with no saplings present: To indicate that a subplot was 
measured but had no saplings present, enter a row for the subplot and the 
code “NOSPEC” in the species code column.  

 Missed subplots (not measured): For standard 20×20-m plots in NVS Data 
entry, all of the standard subplots are assigned to the relevant project 
methods. If a subplot was not measured (i.e. not that it didn’t have any 
saplings present but that it was not actually measured and there is no record 
of that subplot on the datasheet) then record a plot note listing the subplot(s) 
that were not measured. As no data is entered for the subplot(s) it will be 
detected in the validation for the plot, but the note will allow the entries to be 
quickly checked for completeness. 

 Changing the subplot field: If data was mistakenly entered for the incorrect 
subplot, click on the subplot observation you want to change and then click 
the arrow to open the drop down menu and select the correct subplot for that 
observation. 
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   Missing data: Occasionally, field staff may not record any count data 
against the species code on the field sheet. In such cases, enter a ‘P’ for 
presence and use the operator note function to record a note (e.g. [NO 
COUNT RECORDED]). See Section 6 for further information on adding 
operator notes. 

 Data validation: If you wish to see a list of warnings or errors part way 
through entry of sapling count data, click on the ‘Validate All’ toolbar button. 
This function is also called automatically when you save or exit. Use the 
numbers 1–6 to view more or less detail under each method and subplot.  

 Advancing to the next plot: When all of the sapling data for the plot has 
been entered, save the data, deal with any validations and either go directly 
to the next plot (click the forward arrow or use the View menu) or enter other 
types of data for the current plot. Ensure that all data is entered for the 
correct plot number. 

8.5 Seedling Count 

 Open the seedlings form for a plot: In the Projects list open the node of the 
project you’re working on to reveal the methods list. Click on ‘Seedling 
Count’. The ‘Seedling Count’ method will appear in the Plots tab. Double-click 
on the plot name to open the data entry form for that plot. This is where the 
seedling data is entered. 

 Click on Edit Mode button to enable editing. 

 Show Header: Click ‘Show Header’ on the top tab to open a header where 
party data can be entered i.e. the names of the people measuring and 
recording this data. See section 4.2 for further detail. 

 Inserting subplots: As this method is measured by subplot (named 1–24), 
the form has a ‘Remaining Subplots’ list. To add the first row for the next 
remaining subplot, click the ‘Add Sub Plot’ toolbar button. To add the first row 
for a subplot other than the first in the list, select the required subplot from the 
‘Remaining Subplots’ list. 

 Species codes: Enter species codes in the ‘Verb. Code’ column. Either enter 
the full six-letter code or select the correct code from the dropdown list. For 
further information on species codes, see Section 9. 

 Seedling presence or count: Enter the seedling presence (P) or count in 
the column for each height tier. If no presence or count has been recorded 
against a seedling species, enter a P in the <15cm tier, and record a note 
(using square brackets to indicate that it is an operator note) in the notes field 
(e.g. “[NO COUNT RECORDED]”). 

 Inserting rows: To add subsequent rows for the current subplot, click the 
‘Add Species’ toolbar button. 
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 Subplots with no seedlings present: To indicate that a subplot was 
measured but had no seedlings present, enter a row for the subplot and the 
code “NOSPEC” in the species code column.  

 Missed subplots (not measured): For standard 20×20-m plots in NVS Data 
entry, all of the standard subplots are assigned to the relevant project 
methods. If a subplot was not measured (i.e. not that it didn’t have any 
seedlings present, but that it was not actually measured – there is no record 
of that subplot on the datasheet) then record a plot note listing the subplot(s) 
that were not measured. As no data is entered for the subplot, it will be 
detected in the validation for the plot, but the note will allow the entries to be 
quickly checked for completeness. 

 Changing the subplot field: If data was mistakenly entered for the incorrect 
subplot, right-click and select ‘Change Subplot’. This will open a window 
where the correct subplot can be selected from a list. Double-click on the 
correct subplot to select it, and then close the window. 

 Data validation: If you wish to see a list of warnings or errors partway 
through entry of seedling count data, click on the ‘Validate All’ toolbar button. 
This function is also called automatically when you save or exit. Use the 
numbers 1–6 to view more or less detail under each method and subplot. 

 Advancing to the next plot: When all seedling count data for the plot has 
been entered, Save the data, deal with any validations and either go directly 
to the next plot (click the forward arrow or use the View menu) or enter other 
types of data for the current plot by going back to the ‘Plot Method Data’ 
window. 

 
 

9 Species Codes 

 Collected specimens awaiting identification: Unknown species are often 
collected and given an interim ‘tag name’ on field-sheets, until such a time as 
the specimen can be properly identified. Where the identity of a specimen is 
yet to be resolved, type the tag name in the ‘Verb. Code’ column. If the tag 
name recorded on the field-sheet is longer than ten letters, enter a sensible 
abbreviation of it (ensuring that it does not conflict with any valid NVS code). 
Check that the entry is highlighted as an error code (to ensure it will be 
picked up during data validation) and type the full tag name (exactly as 
recorded on the sheet) in the operator notes column, using square brackets 
(i.e. [UNCfine collected]). Such entries need to be resolved once the 
specimens have been identified. 

 Species codes: The procedure for entering species codes is the same for all 
plot methods. Enter species codes in the ‘Verbatim Code’ column. Either 
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enter the full six-letter code, or select the correct code from the dropdown list. 
The NVS code will default to the verbatim code when the code is recognized. 

 Species code list: In NVS Data entry the species code list includes names 
that are recorded in both historical and recent NVS projects. ‘Out-of date’ 
names, representing older taxonomic concepts, are present along with more 
recently accepted taxonomic names. This means that if field staff used an 
older taxonomic concept for a species, the data can still be entered. 

 Species not on NVS list: Occasionally a recently described species may not 
yet have been added to the NVS species code list. Enter the species as an 
‘error’ code, and type the full species name in the notes column. To resolve 
this error contact the NVS Database Administrator (email: 
nvs@landcareresearch.co.nz ) who will update the NVS list and provide you 
with an updated authority file containing the new code/s. 

 Commonly used ‘tag’ names: Some tag names are in widespread use and 
many of these are valid NVS codes and are on the NVS list. Where 
appropriate, document important details on the use of a tag name as a plot 
note, in particular where a reference to a published work can be provided. 
Some tag names on the NVS list are used where a more precise 
identification could not be provided (e.g. ’ORCHID’). 

 Updating the species name list: A periodic update process for the NVS 
names list will allow the addition of newly added NVS species codes. 
Registered users of NVS Express will be notified of these updates. 

 Species defaults options: The correct NVS six-letter species codes for 
some taxa are unintuitive (refer to the plot measurement manuals for full 
details; see http://nvs.landcareresearch.co.nz/ ). For these species codes, for 
which confusion potentially exists, the ‘Species Defaults’ function can be 
used to select the default taxon for the project. 

o ‘Duplicate’ codes: When a potentially incorrect code (‘duplicate 
codes’, e.g. PSECOL) is entered in the ‘Verb. Code’ column, a 
drop-down list will identify several taxa that field staff may 
potentially be referring to.  

 

mailto:nvs@landcareresearch.co.nz
http://nvs.landcareresearch.co.nz/
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o Select the taxon intended for the code (e.g. Pseudowintera 
colorata). Field staff may need to be asked to confirm what 
taxon was intended.  

o If it is unclear which taxon was intended, record an operator 
note for the plot to identify that the data needs to be checked 
(e.g. [PSECOL written on field-sheet, check with field staff that 
the intended taxon was Pseudowintera colorata], see Section 
9). 

o Once a taxon has been selected for a duplicate code, NVS Data 
entry will check whether that taxon should become the default 
for the species code entered. If ‘OK’ is selected, the next time 
the code is entered the dropdown species code list will jump to 
the default taxon for the code. 

 

  
 

o Viewing species defaults: Default species options can be viewed 
by clicking on the ‘Species Defaults’ button on the toolbar. 
Default species codes can also be edited in this window. Note: 
The ‘Species Defaults’ selection is active for the current project 
only.  
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o Updating species defaults: A default species selection can be 
changed and re-applied. Click on the ‘Species Defaults’ button 
and then double click on the species you would like to change. 
Select the preferred default species from the drop down list by 
double clicking on it. You will then be asked to confirm that you 
want to update all entries of the particular code throughout the 
project. 

 

  

o If desired, only default codes can be displayed in the dropdown 
species code lists that appear when entering stem diameter, 
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sapling or seedling count data. Select this option at the bottom 
of the drop-down species list. 

 
 

10 Data Validation 

All data entered must be validated before upload to the NVS databank. Data should 
be validated during data entry (section 10.2) as well as once all data entry is 
complete (section 10.3). 
 

10.1  Quality Assurance procedures for data entry 

 
The inbuilt data validation functions in NVS Data entry help to identify errors in the 
data by ensuring that valid data is entered in each field, but typos by data entry staff 
may lead to unidentified errors in your data. As a general rule-of-thumb it is 
suggested that data entered for 10% of plots should be checked, line-by-line, directly 
against field sheets for the presence of typos.  
 

10.2  Data validation during data entry 

 Validation functions: These enable checks on the values entered both 
during and following data entry. Validation functions produce either errors or 
warnings. Data with errors cannot be saved. Data with warnings can be 
saved. 

 Species code warnings: Unknown six-letter species codes are immediately 
highlighted in yellow during data entry, but will also be identified during 
validation.  
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 Incorrect value errors: Constraints on some data fields prohibit the entry of 
inappropriate values. In other data fields inappropriate values may be 
accidentally entered but will be identified by the validation functions. 

 Missing-value warnings: Missing values in some data fields also produce a 
warning. In some tables species codes may also be highlighted where there 
has not yet been any data entered against them. 

 

 
 

 Validation function: All data entry forms in NVS Data entry have a ‘Validate 
All’ button on the toolbar. Click the button to obtain a complete summary of 
errors and warnings identified for the plot. 

 

 
 

10.3  Post-entry data validation 

 
Post-entry data validation and correction of errors should be undertaken prior to 
uploading data to the NVS databank. This will ensure a high-quality dataset is 
archived. If errors remain unresolved when data is uploaded, the NVS databank 
administrator will contact the ‘Primary contact’ for the project to try and resolve any 
outstanding data issues. 
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 Performing post-entry validation: Post-entry validations operate at a higher 
level, identifying any unlikely data that could be indicative of errors. All data 
for each plot method can be checked at one time. 

o Select the ‘Analysis’ tab on the bottom-left side of the main 

screen. Then click on . The screen below 
will appear. Click the ‘Select Project’ button to find and select 
the project you are interested in.  

o Validations can also be performed on a single plot basis. 
Choose the plot from the Single Plot drop-down list. 

o By default all project methods and all validation tests are 
selected – unselect any that you do not wish to run. 

o Click on the ‘Go’ button. 

 

 
 

 Viewing results: The results are shown as a list in the Plot Methods grid in 
the lower part of the screen, ordered by method. You can edit those plot 
methods with errors by double-clicking on the plot or subplot. The usual form 
for editing that method is displayed for the plot: 

 Errors and warning are highlighted immediately in the data. 

 The validation window displays immediately (before editing) – some 
validations relate to missing rows and therefore cannot be highlighted. 
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 After closing the edit form, the post-entry data for that plot method is 
updated. 

 Use the buttons 1–4 to view more or less detail under each method and 
subplot. The ‘*’ button displays the maximum level of detail. 

 

 To view the validation results as a table in the Plot Methods grid in the lower 
part of the screen, tick the checkbox Show as table. This is useful for sorting 
and looking at validations in groups. 

 The Export button allows you to save the validations as a separate .csv file. 

 A description of the validation messages and suggested solutions can be 
found in Appendix 1. 
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11 Uploading Data to the NVS Databank 

 
Once data entry is complete and all data validations and warnings have been 
checked and corrected where possible, the project should be exported so that it can 
be uploaded to the NVS Databank. Data for the project is sent back to the NVS 
Databank as a zip file, which is created in NVS Data Entry. 
 

 Registration: NVS Express Data Entry users must be registered and logged 
in before data can be uploaded (see http://nvs.landcareresearch.co.nz/ ). 
This is required so that the databank has a record of where deposited data 
came from and allows the NVS Database Administrator to clarify any data-
related issues that may arise during the import process. 

 Uploading data: Select ‘Zip Project For Upload’ from the File menu Note: 
This is different from “Export project data”, which will produce .csv files 
containing the data. It is important that you download the actual project files. 

 

 
 

 If you have run the validations and corrected any errors select ‘OK’ to create 
the zip file. If not, click cancel and run the validations before exporting the 
data. 

 

http://nvs.landcareresearch.co.nz/
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 Once created, the file may be uploaded via the Internet 
(http://nvs.landcareresearch.co.nz/) or emailed directly to 
nvs@landcareresearch.co.nz  

 Contact the NVS Database Administrator (nvs@landcareresearch.co.nz ) for 
further information on uploading data. When the data is uploaded to NVS 
further validation checks will be undertaken, and you will be queried on any 
errors or abnormalities identified. 

 Metadata: Data deposited with NVS must be accompanied by metadata that 
describes a dataset’s content. A metadata form is available on the website to 
assist you in compiling this information. Email the completed form to the NVS 
Databank team (nvs@landcareresearch.co.nz ). To help the NVS Database 
Administrator to correctly link the metadata file with your uploaded dataset, it 
is important that the names of both files match. 

 
Checklist for uploading data: 
 

Ä Complete data entry 

Ä If the project is a remeasure ensure the project name and plot names match 
the previous measurement  

Ä If the project is a remeasure ensure any tag corrections and species 
corrections are clearly noted 

Ä Run the data entry validations (under the analysis tab), check all validations 
and correct errors 

Ä Export the zipped project file 

Ä Create metadata 

Ä Send the project file and metadata to the NVS Database Administrator 
(nvs@landcareresearch.co.nz) 

 
 

12 Troubleshooting 

 
If you experience any difficulty in the use of this program please feel free to contact 
the NVS Database Administrator (nvs@landcareresearch.co.nz ) for advice. 

http://nvs.landcareresearch.co.nz/
mailto:nvs@landcareresearch.co.nz
mailto:nvs@landcareresearch.co.nz
mailto:nvs@landcareresearch.co.nz
mailto:nvs@landcareresearch.co.nz
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NVS Express has only recently been developed and we are interested in any 
feedback that you may have. If you get any error messages whilst using this program 
please contact us. Knowing exactly what was being done and receiving the text of 
the error will help us isolate the problem. If you get a message that includes the note 
“Full details have been copied to the clipboard” the error details have been copied 
onto the windows clipboard. This means that the error can be pasted into an email or 
word document. 
 

13 Appendix 1: Data Entry Validation errors and their resolution 

There are a number of data entry validations that have been included in the NVS 
Express tool. The following is a list of the Data Entry Validation Messages: 
 
Area is missing 
Reason: No area has been recorded for a plot or sub plot. 
Solution: Check the area and enter where possible. 
  
Area differs from calculated value 
Reason: The area calculated using the tape lengths from the plot layout differs from 
that indicated by the size; e.g. a plot may be entered as 20 m × 20 m but have a 
calculated size of >400 due to differing tape lengths.  
Solution: Check that the tape lengths are entered correctly and that the difference is 
not significant. This validation is bringing this difference to your attention but it is not 
always a problem as the actual tape lengths are affected by terrain. 
 
Counted Species Density - Species had density greater than the maximum 
Reason: The counts in Quadrat sapling or Quadrat seedling data exceed the 
maximum expected density for the species, which has been derived from existing 
data in the NVS databank.  
Solution: Check that the relevant data is entered correctly.  
 
Deprecated Species – Species names no longer in use 
Reason: You have entered a species code that is in the NVS list but is no longer in 
active usage. 
Solution: Check the entry of this species. If this code is entered correctly, check that 
this is a recognised name through searching the New Zealand Plants Database at 
http://nzflora.landcareresearch.co.nz/ 
  
Diameter – Observations had diameter greater than their species maximum 
Reason: A stem has been entered with a diameter greater than the expected 
maximum size for the particular species, which has been derived from existing data 
in the NVS databank. 
Solution: Check that the stem has been entered correctly. 
 
Duplicate Individual 
Reason: There are duplicate tags within a plot or sub plot (stems without tags are 
excluded). 
Solution: Check duplicates to see if they can be resolved. Sometimes duplicate tags 
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can be resolved by reference to the tag sequence or previous measurements. 
 
Duplicate Taxon 
Reason: There are duplicate taxon rows within a plot or sub plot (for Recce, Quadrat 
seedling, Quadrat sapling). This validation will normally prevent saving the record 
after entry or editing. 
Solution: Edit the first record of the species to include the data for both records. For 
example, if there are two Recce records for the same species, enter the 
species using the higher cover class recorded for each tier. For sapling and seedling 
data counts can be summed. 
 
Individual Entry Validation – Item duplicate tag – Item has duplicate tag indicated: (* 
or ?) 
Reason: There are multiple tags in a plot with the same tag number. One of these 
tags should be entered with a * followed by the last three tag digits (in older projects) 
or as the full tag number followed by ?? 
Solution: Check whether the tags were entered properly, whether it is a problem with 
reading the handwriting or with the use of two similar tag sequences. If it looks like 
an obvious recording error, please make an operator note against the tag. 
If it is not possible to resolve these as being different numbers then leave them 
marked as duplicates. 
 
Individual Entry Validation – Item Obs has missing tag 
Reason: An individual item (normally a stem diameter) has been entered without a 
tag number 
Solution: Check whether a tag number has been recorded. If it has been recorded, 
enter the tag number, otherwise a note should be made. This note can be a general 
note against the entire method (using the Notes option on the toolbar) in the case 
where no stems were tagged. Alternatively a specific operator note can be made 
against the individual stem (in the Notes column) where this is a single omission, e.g. 
[no tag recorded]. 
 
Taxon Entry Validation – Taxon Obs no data – Taxon Obs has no data entered, 
note: (if any) 
See description under “ Individual Entry Validation – Item Obs no data – Item Obs 
has no data entered, note: (if any)” 
 
Individual Entry Validation – Item Obs query – Text of note ? 
Reason: The note for an item observation (i.e. diameter or orthogonal width) 
contains ‘??’. This is usually used to denote a duplicate tag or another problem to be 
checked.  
Solution: Check the reason for the note and resolve if possible. 
 
Individual Entry Validation – Item Obs remeasure note – Remeasure note: Text of 
note $ 
Reason: A remeasurement note has been recorded (as described in the NVS-Data 
Entry manual (Vickers et al. 2009). 
Solution: This is an operator note that is designed to bring a remeasurement issue to 
the attention of the NVS Administrator when the data is uploaded into the main NVS 
database. Appropriate notes include: 
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$Tag corrected from xxx$ denotes a tag correction for an existing tag 
$Retag of xxx$ denotes a retag of an existing tag 
$ReID from xxx$ denotes the re-identification of a tagged individual 
$Subplot corrected from xxx$ denotes a change in the subplot that a tagged 
individual is measured in. 
Please see section 8.3.1 in the NVS-Data Entry manual (Vickers et al. 2009) for 
further details. 
 
Individual Entry Validation – Item Obs verbatim species code – Verbatim code is 
different to the species code 
Reason: The 'verbatim' code entered differs from the species code selected for an 
individual item. This can occur for a couple of different reasons: 
1. Where there are mis-spellings and the verbatim code is entered as recorded but a 
different code has been selected as the NVS code.  
2. Where a tagged stem is remeasured with a different species identification. In this 
case the verbatim code represents what was recorded in the current year and the 
NVS species code shows what was recorded in previous year(s). 
Solution: Check the reason for this difference.  
1. It is acceptable to retain a different verbatim code where there is a mis-spelling as 
this shows where any assumptions have been made by the data entry operator.  
2. Where there are two different identities for a tagged individual the NVS code can 
be changed when there was a clear note recorded stating that the new identification 
was checked and correct. This can only be done in the main NVS database. NVS 
Express Data Entry users need to record a remeasurement note in the following 
format: $ReID from [previous code]$ 
 
Individual Entry Validation – Missing Taxon – Taxon is missing 
Taxon Entry Validation - Missing Taxon – Taxon is missing 
Reason: A row has been entered without any species being recorded. 
Solution: First check whether this is a data entry error.  
Sometimes people will create a new row for a note, e.g. Seedling plot 13 'in stream'. 
This is not appropriate. Any such note should either go against an observation or into 
the general notes found on the toolbar.  
If using the general notes remember to record which plot this refers to, e.g. Plot 1EX, 
seedling plot 13, in stream.  
If there is a note that there are no species in a particular subplot then the code 
'NOSPEC – No species on plot' can be used, rather than leaving the species blank. 
Be careful not to make assumptions where there are no recorded notes, as it is 
possible that a subplot may not have been measured rather than having no species 
present. 
  
Individual Entry Validation – Species Mapping – Species is not the default for … 
Taxon Entry Validation – Species Mapping – Species is not the default for … 
Reason: Where there is a duplicate code (the intuitive six-letter code matches more 
than one species), one of the options has been selected as the default species for 
the project. Whenever this duplicate code is entered subsequently, the default 
species will be automatically selected. This validation is generated where there is a 
default selection but the same code has been used elsewhere in the project to 
represent one of the other duplicate options. 
e.g. COPPSE is the intuitive code for two species: Coprosma pseudocuneata (NVS 
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code = COPPSE) & Coprosma pseudociliata (NVS code = COPPSC). If a default 
selection has been made so that all entries of COPPSE default to COPPSE 
Coprosma pseudocuneata then a validation will be brought up if COPPSC Coprosma 
pseudociliata is selected for the duplicate code COPPSE. 
Solution: Check that the correct species has been selected for this duplicate code – 
you may have to check with the field staff. If you have selected the incorrect species, 
you can correct all entries in one action by using the 'Species Defaults' option on the 
toolbar. Edit the species in the Species Default list and select the appropriate 
species. You should be asked if you want to update all occurrences of this species 
code. 
It is also possible that both species might be present in the one project, in which 
case it is not appropriate to set a default code. 
 
Individual Entry Validation – Unknown Taxon Verbatim – Taxon is unknown for 
Verbatim code 
Reason: An unknown six-letter code has been entered. The code entered is not in 
the current NVS code list. 
Solution: Check the recorded code with the field staff to obtain the full species name. 
If the recorded code is a misspelling, then enter the correct code in the NVS code 
field, leaving the Verbatim code as it is (unless a correction has been made to the 
original plotsheets). If the species is not on the NVS code list, please send the full 
species name to the NVS database administrator [Hazel Broadbent, 
nvs@landcareresearch.co.nz ], who will generate a new code for you. In the interim, 
type the full species name into the Notes column. 
If no definite species can be obtained for the recorded code, you may wish to 
discuss with the field staff whether this record should be removed. If this is the case, 
please make a note regarding this. When using the general notes remember to 
record which plot this refers to, e.g. Plot 1EX seedling plot 1: unknown code 'hairy 
herb' not entered.  
Alternatively, if you wish to retain the species but it is not identified, you may assign it 
to a general descriptive NVS code, e.g. FERN, HERB, GRASS, TREEFE, ORCHID, 
DANDEL, THISTL. Note that we do not recommend the routine use of these codes – 
all possible attempts should be made to resolve species to specific or generic level. 
 
Individual Species Density - Species had density greater than their maximum 
Reason: The values of individuals, such as tagged stems, exceed the maximum 
expected density for the species, which has been derived from existing data. 
Solution: Check that the relevant data is entered correctly.  
 
Non-tree measured – Species entered is not on the validation list for this type of data 
– please check that the species code is correct 
Reason: A species has been entered for a method where it is not on the list of 
validated species for the method.  
Solution: Check that the species was recorded under the particular method. It may 
also be necessary to consider whether the inclusion of the species is consistent with 
the standard methodology, for example if a crown fern has been recorded as a 
sapling. 
 
Operator note: Text of note [] 
Taxon Entry Validation – Taxon Obs operator note – Operator note: Text of note [] 



       
 

Landcare Research 

59 

Reason: An operator note has been entered in the Notes field. This validation 
displays the content of the operator note. 
Solution: Check to see whether this note requires any action. 
 
Plot has no observations entered 
Reason: This occurs in a subplot-based method (diameters, saplings, seedlings) 
when nothing has been recorded against a subplot.  
Solution: Where there is a note that there were no individuals (e.g. 'no saplings in A') 
this validation can be removed by adding the code 'NOSPEC No species in plot' to 
the appropriate subplot (A in this example). 
 
Recce Species – Some species measured in other Methods were not included in 
Recce 
Reason: This occurs when a species was recorded on another method but was not 
recorded on the Recce.  
Solution: To correct this omission please add the species to the Recce as follows: 
*For species in diameters – add as a presence in the 0.3–2 m tier with an operator 
note:  [Added to Recce as recorded in diameter method] 
*For Species in saplings – add as a presence in the 0.3–2 m tier with an operator 
note:  [Added to Recce as recorded in sapling method] 
*For species in seedlings – add as a presence in the appropriate tier (with reference 
to seedling tier, will be either 0–0.3 m or 0.3–2 m on Recce) with an operator note:  
 [Added to Recce as recorded in seedling method] 
 Some things to watch for: 
– Genera recordings: only add these if there is not a species in this genus already on 
the Recce. 
– Synonyms (e.g. PSESIM = RAUSIM). 
– Previous tag identifications will also come through on this validation so you may 
already have these under the current identification.  
– Watch out for duplicate codes. If a duplicate is already present, determine whether 
both or only one of the duplicates are present before adding. 
 
Individual Entry Validation – Missing Taxon – Taxon is missing 
      See description under “ Taxon Entry Validation - Missing Taxon – Taxon is 
missing” 
  
Taxon Entry Validation – Taxon Obs operator note – Operator note: Text of note [] 
      See description under “Operator note: Text of note []” 
 
Taxon Entry Validation – Taxon Obs no data – Taxon Obs has no data entered, 
note: (if any) 
Individual Entry Validation – Item Obs no data – Item Obs has no data entered, note: 
(if any) 
Reason: A species or tag has been entered with no data against it. 
Solution: Check whether this data has been entered correctly. If no data was 
recorded for the species, you can make an operator note, e.g. [no data recorded for 
this species]. For sapling and seedling records it is often possible to make an 
assumption, as long as the assumption is recorded. For saplings it is often assumed 
that if a species has no count recorded then there was at least one sapling. In this 
case a count of 1 can be entered and an operator note recorded in the notes column: 
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[no count recorded, assumed 1]. Likewise, if no seedlings were recorded but a 
species was written then it can often be assumed that the particular species was 
present in the <15 cm tier. In this case a ‘P’ is entered in the <15 cm tier and an 
operator note recorded in the Notes column: [no count recorded, assumed presence 
in <15 cm tier]. 
  
Taxon Entry Validation – Species Mapping – Species is not the default for … 
See description under “ Individual Entry Validation – Species Mapping– Species is 
not the default for …” 
 
Taxon Entry Validation - Taxon Obs query - Text of note ? 
Reason: The note for an item observation (i.e. Recce, Quadrat sapling or Quadrat 
seedling) contains ‘??’. This is usually used to denote a problem to be checked.  
Solution: Check the reason for the note and resolve if possible. 
 
Taxon is unknown for Verbatim code  
Taxon Entry Validation – Unknown Taxon Verbatim – Taxon is unknown for Verbatim 
code 
Reason: An unrecognised six-letter species code has been entered. 
Solution: Check that the species was entered correctly. The field recorder should be 
contacted to provide the full species name. If the code is misspelled, the Verb. code 
should be left as recorded and the correctly spelled code should be entered under 
the NVS code. For example if 'WAIRAC' is recorded and found to be a misspelling of 
'WEIRAC' then the Verb. code should be WAIRAC and the NVS code should be 
WEIRAC. 
If the species is not on the NVS list then the full species name should be entered in 
the Notes field next to the species. This name should be sent to the NVS 
Administrator so that a new NVS code can be created. An email will be returned 
specifying the new code. 
 
Taxon Obs verbatim code is different to the species code 
Reason: This occurs when a NVS code different to the Verbatim code is selected.  
In many methods this can be deliberately used for when there is a spelling error on 
the plotsheets. For example if 'WAIRAC' is recorded and found to be a misspelling of 
'WEIRAC' then the Verbatim code should be WAIRAC and the NVS code should be 
WEIRAC. 
In remeasured diameters this can occur when a project is uploaded into the main 
NVS database and the current species recorded (Verb. code) is different to the tag 
species ID from the past measures (NVS code). Corrections will be made to the NVS 
code in the main NVS database where there is a specific remeasurement note 
detailing that the previous ID was incorrect. 
Solution: Check the reason for this difference and correct any entry errors.  
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